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About This Guide

This guide is a complement to Quick Installation Guide. The Quick Installation Guide
provides instructions for quick internet setup, while this guide contains details of each
function and demonstrates how to configure them.

When using this guide, please notice that features of the router may vary slightly
depending on the model and software version you have, and on your location, language,
and internet service provider. All screenshots, images, parameters and descriptions
documented in this guide are used for demonstration only.

Conventions

In this guide the following conventions are used :

] Underlined words or phrases are hyperlinks. You can click to
Underlined _ . - .
redirect to a website or a specific section.

The content and text that needs to be emphasized on the web
Teal page is the theme color , including menus, items,
buttons, etc.

The menu structures to show the path to load the
corresponding page. For example,More > Network > Mode

>
Selection means the Mode Selection function page is under
the Network menu that is located in the More tab.
Do not ignore this type of comment, it is to remind you to
Note: better use the device, to avoid the operation of the error that
will cause the function to be invalid.
- Indicates important information that helps you make better
ips:
P use of your device.
More Info

The latest software, management app and utility are available from the Download
Center at https://docs.wavlink.xyz/Firmware/ .



https://docs.wavlink.xyz/Firmware/

A quick installation guide can be found in this guide.

Specifications can be found on the product page at https://docs.wavlink.xyz/.

If you encounter any issues, please don’t hesitate to email contact@wavlink.com to
provide feedbacks or contact online customer service, thank you !

Speed/Coverage Disclaimer

*Maximum wireless signal rates are the physical rates derived from IEEE Standard
802.11 specifications. Actual wireless data throughput and wireless coverage are not
guaranteed and will vary as a result of 1) environmental factors, including building
materials, physical objects, and obstacles, 2) network conditions, including local
interference, volume and density of traffic, product location, network complexity, and
network overhead, and 3) client limitations, including rated performance, location,
connection, quality, and client condition.


https://docs.wavlink.xyz/
mailto:contact@wavlink.com

Overview

This chapter contains the following sections:

e Qverview

e LED Indicators

e Basic Info

1. Overview

@ LED Indicator
@ Power Port
® On/Off Switch

@ Pair Button



® Reset Button

® Internet/LAN Backhaul Port
@ Touchlink Pad

LAN Port

1 . Pair Button: Press and hold for 2 seconds to add an extra mesh device to the
existing Wi-Fi system.

2 . Reset Button: Press and hold for 6 seconds to reset the mesh device

2. LED Indicators

Blue light Internet is connected
Slow flashing (Red light) Internet is disconnected
Quick flashing (Red light) The extender is disconnected
Flashing (Blue light) Touchlink/Pair mode is on

3. Basic Info

Default IP: 192.168.20.1

Login: http://wavlogin.link

Mesh SSID: WAVLINK-Mesh_ XXXX
Touchlink SSID: WAVLINK Touch


http://wavlogin.link/

Setup Guide

This chapter introduces steps for setup guide:

Step 1: Access to the Internet

Select one of mesh devices as your router, connect its Internet LAN/Backhaul to the
modem then plug it in a power outlet.
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Cable

Step 2: Connecting the Router

2.1 Via Wireless

Turn on your Wi-Fi, search SSID and connect to it; then you can
start configuring.
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Not connected

d Connections are available

Wireless Network Connection

WAVLINK-Mesh_XXXX alll

Connect automatically

For Windows users

2.2 Via Cable

Cable

Turn Wi-Fi Off

WAVLINK-Mesh_XXXX %

Join Other Network....
Create Network....

Open Network Preferences...

For Mac users

Connect to LAN port

Connect Ethernet cable to your PC/laptop and device LAN port,then you can start

configuring.

Step 3: Logging in to Management Page

Launch a browser from your laptop/PC or smart phone and enter http://wavlogin.link or

in the address field.


http://wavlogin.link/
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Welcome to WAVLINK

EXPERIENCE NOW

-

. Click here to download the
“ " WavRouter APP

Step 4: Selecting WAN Mode

Select the WAN Type according to the type of your network.

WNLlNK see the world

Internet access method

WAN Type DHCP v

Internet VLAN ID

Auto Mesh D

Auto Mesh

If the ISP provides you with an account and password, please choose PPPOE. If the ISP
doesn't provide any parameters, and the computer can access the Internet directly by
connecting the Internet cable, then can surf the Internet, please choose DHCP. If the ISP
provides you a fixed IP and other information, please choose Static IP.

Step 5: Basic Settings

Select your Country/Region, and Time Zone; for your network security, we suggest that
you set a new login password following the rules accordingly.



WNLlNK see the world

Country code/Time zone

Country/Region Global o

Time Zone (UTC-00:00) Dublin, Edinburgh, Lisbon, London hd

Wi-Fi Settings Dual-band convergence D

Wi-Fi Mame WAVLINK-Mesh_282E

Wi-Fi Password 8 to 30 characters(Same as the management password) ¢

Device management password Same as the Wi-Fi password ()
I BACK ] SAVE

The Dual-Band convergence switch is on by default. 2.4G WiFi and 5G WiFi use
the same SSID and password. Turning off the Dual-Band convergence switch allows you
to set the SSID and password for 2.4G WiFi and 5G WiFi separately.

Step 6: Done

Please wait patiently for the process to complete, then you can enjoy your wireless
network.

WNLlNK see the world

Setting successful, please wait for the setup to complete. Use the new Wi-Fi password

to connect to the Wi-Fi.

Wi-Fi Name * WAVLINK-Mesh_282E

Wi-Fi Password : SR g

4% Please wait...

Step 7: Switching to Other Modes

Click "More", enter Network and select "Mode Selection". You can select Router Mode
and LAN Bridge (AP Mode).



WAYLINK sce the world

Home Network

Device Status

Mode Selection Help
Network e . . Router Mode
Mode Selection LAN Bridge (4P Mode) v
Internet Convert the wired network of the
. network provider into a Wi-Fi signal to
LAN Smart DHCP Service () realize the functions of wireless
. Internet access and wired Internet
Static 1P WAN Status Connected access.
IPvE -
IPTV/VLAN When extending an existing networlk in
ic DNS Access Point (AP) mode, it is important
Cynamic to ensure that the WAN port of this
Mode Selection . device is connected to the network via
a cable. Please note that some
5QM QoS functions may not be available in this
. mode, so it is advisable to refer to the
URL Filter on-screen display or user manual for
detailed information.
Wireless > Note:
if you need to set up the device after
Mesh > successfully connecting to the superior
in this mode, you need to connect to
Net Guardian > the Wi-Fi of the device and access the
web pages by http://wavlogin.link/.
NAT Forwarding > Repeater Mode
Bridge(Recommend) ;
Security > This mode can relay any wireless
network signal, but does not have
VPN > DHCP service function. IP is managed
by the upper device. Select the
Remote Access > wireless signal you want to relay and
enter the password of the relay signal.
NET Tools > Not_e that if you need to set up tr?ls
device after successful relay in this
mode, please visit the setting page via
System > http://wavlogin.link/.

Logout WISP



More Mesh Devices

Generally, a mesh router device supports up to devices(including the existing mesh
device). Therefore, if you need to add more mesh devices to build up a stronger network
in your home, you simply need to pair the new mesh devices with the existing network.

1. Click “Mesh” and then select “Mesh Devices”.
2 . Click on “ADD” and then follow the prompts on the screen.

Wireless Network  Clients More

WNLlNK see the world

Device Status .
Mesh Devices Help

Network > Eye Reaming

Wireless roaming technology allows

your devices to seamlessly switch

between two mesh routers. When you

Mesh w - move away from one router and closer

= Router 192.168.20.1 [ it el 3 to another, it will automatically

disconnect the current connection and
connect to the closer router for a

Advanced > smoother network user experience. No
manual intervention is required during
the switch and it will not affect the
network connection.

Wireless >
Status Name P MAC Signal Strength Operation

Mesh Devices .

Topology Map
Net Guardian >

NAT Forwarding >
Roaming Threshold

Security > The wireless roaming trigger threshold

should only be set by experienced
VPN > professionals. If you lack professional
experience in setting the roaming
trigger threshold, it is recommended
that you keep the default settings to
aveoid negative impacts on the network
NET Tools > user experience.

Remote Access >

System 3 Topology Optimization

When your paired devices are greater

Logout than or equal to 3 devices, after all
devices are paired, optimization can be
turned on. This function can
automatically adjust the optimal path
according to the signal strength
between the devices, so as to ensure
that all sub-routes and corresponding
upper-level devices have the best
signal connection status for optimal
network coverage.

Threshold of Topology
Optimization

3 . After scanning, please make sure the device you want to add is listed, and click
“ADD”. If not, make sure the Mesh extender to be added is in a paired state. Click
“RESCAN".



Add New Mesh Device

Name Pair Key

Extender_C1BA BuFCLIBA

BACK RESCAN ADD

After configuring the main router, when the main router has the network, press and hold
the pair button of the main router and the mesh extender at the same time for

seconds. When LED lights become solid blue, the pairing process is successfully
completed.



Firmware Upgrade

This chapter contains the following sections:

* Local Upgrade

* Online Upgrade

If you need to update firmware, please proceed as the following steps:

Option | : Local Upgrade

1. Download the latest firmware file from our official website.

2. Extract the firmware from the downloaded file.

3. Loginto Then click “More”, open “System” and select “Firmware
Upgrade”.

4. Click on the red arrow's place to locate the extracted firmware file.

5. Click on “UPLOAD FILE” and choose “Apply”, and wait for the firmware upgrade
process to complete.

WAV LINK sce the world : C

Home  Wireless Network  Clients

Device Status
Local Upgrade

Network >
Manually upgrade the firmware. You can download a new firmware file from the official WAVLINK website. The following devices are the same model as the devices you
Wireless > currently connect to.
Mesh > O Mesh Device Current Version
Net Guardian > O Router M51X3B_V240729
1
a Extender_C1BA M51X3B_V240729
NAT Forwarding >
, New Firmware Choose File = /
Security >
VPN > UPLOAD FILE
Remote Access ’ The following devices are different models from the devices you are currently connected to. You can upgrade them by clicking the Upgrade link to access the Manual
Upgrade page.
NET Tools > paracepag
Mesh Device Current Version Upgrade Link
System W
Firmware Upgrade . Extender_C2BA M51X3 V240411 2
Change Password Online Upgrade
System log
If the device has Internet access, you can upgrade online. After checking the latest firmware version, click the "ONE-CLICK UPGRADE" button.
Time Zone
Led Control O Mesh Device MAC Curmrent Version Latest Version Status
Backup & Restore [ Router g m~57:50 MS1X3B_V240729 No new version available Not upgradable
Timing Reboot O Extender_C2BA g C2iBA M51X3_V240411 No new version available Mot upgradable
Logout O Extender C1BA g C1BA M31X3B_v240729 Mo new version available Mot upgradable

CHECK FOR NEW VERSION 'ONE-CLICK UPGRADE



If your all mesh devices are same model, you can check and upgrade your deviecs
together at ®. If the model of your devices are not same, please visit the web interface
of each device and upgrade it in @.

Option Il : Online Upgrade

1. Login to Then click “More”, open “System” and select “Firmware
Upgrade”.

2. Select the Mesh Node Name in ® that needs to be upgraded.

WNLlNK see the world

Home  Wireless Network  Clients More

Device Status
Local Upgrade

Network >
Manually upgrade the firmware. You can download a new firmware file from the official WAVLINK website. The following devices are the same model as the devices you
Wireless > currently connect to.
Mesh > O Mesh Device Current Version
Net Guardian > O Router M51X3B_V240729
O Extencler_C18A M35TX3B_V240729
NAT Forwarding >
3 New Firmware Ch [ha]
Security >
VPN > UPLOAD FILE
Remote Access > The following devices are different models from the devices you are currently connected to. You can upgrade them by clicking the Upgrade link to access the Manual
Upgrade page.
NET Tools > Porace pag
Mesh Device Current Version Upgrade Link
System ~
o Extender_C2BA M51X3_v240411 192,168.20.120
Firmware Upgrade .
Change Password Online Upgrade
System log
If the device has Internet access, you can upgrade online. After checking the latest firmware version, click the "ONE-CLICK UPGRADE" button.
Time Zone
Led Contral O Mesh Device MAC Current Version Latest Version Status
Backup 8 Restore (] Router B RETI5g M31X38_V240729 Ne new version available Mot upgradable
Timing Reboot 3 O Extender C2BA GrsRen COBA M51X3 V240411 Mo new version available Not upgradable
Logout O Extender_C1BA g CLBA M51X38_V240729 No new version available Not upgradable

'CHECK FOR NEW VERSION ONE-CLICK UPGRADE



Touchlink Technology

At the top of the mesh device there is the TouchLink sensing pad; once you touch the
pad with your hand or other devices, the sensing pad will blink in blue, indicating that

TouchLink is in process, then you can search “WAVLINK Touch” and connect to it
without any password.




LAN Backhaul

1. If the wireless signal weakens because of complex environment,you can try the

second option LAN Backhaul.
2. After mesh router is paired with mesh extender, then connect the “WAN” port of

the extender to “LAN” port of your router.

o) (7s




FAQ

Ql. Why doesn't the login page appear after entering
http://wavlogin.link?

e |f your computer is wirelessly connected, please verify that you have connected to
the device's SSID. If your computer is connected via an Ethernet cable, please verify
that the connection is stable.

e Make sure your PC is set to obtain IP address automatically.

e Please make sure you entered the correct website.

Q2. What can I do if | can not access the Internet?

e Make sure your Internet works normally, please contact your ISP (Internet Service
Provider) if it doesn't.

e |nitiate your browser, enter then set up following the quick start guide.

e Reboot your device and try again.

Q3. How do | restore the device to factory default setting?

¢ Press and hold the reset button of the device for © seconds.

Q4. What can | do if | forget my administration management
password?

¢ Please reset the device.

Q5. How do | find the best location for my device?

e Please put your device in a relatively open space to avoid obstacles such as metal
objects, reinforced concrete walls and so on.

Q6. What should | do if | can't have access to on
my android phone?

e We suggest you turn off your mobile Network first before you set up the network,
then turn it on when the configuration is done.


http://wavlogin.link/

Q7. Why the flow monitoring is inaccurate?

e The Hardware NAT Settings' default open status leads to the absence of monitored
data. If you wanna keep the flow monitoring accurate, you have to turn off the

Hardware NAT Settings function manually, which will inevitably increase the CPU
usage.



GNU General Public License Notice

This product includes software codes developed by the third parties. These software
codes are subject to either the GNU General Public License (GPL), Version 2, June 1991
or the GNU Lesser General Public License (LGPL), Version 2.1, February 1999. You can
copy, distribute, and/or modify in accordance with the terms and conditions of GPL or
LGPL.

The source code should be complete, if you want us to provide any additional source
code files under GNU General Public License (GPL), please contact us in these matters.
We are committed to meeting the requirements of the GNU General Public License
(GPL). You are welcome to contact our local office to get the corresponding software and
licenses. Please inform us of your contact details (full address) and the product code. We
will send you a software package with the software and license for free.

The respective programs are distributed WITHOUT ANY WARRANTY; without even the
implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.

Please refer to the GNU General Public License website for further information.
http://www.gnu.org/licenses/old-licenses/Igpl-2.0.html

http://www.gnu.org/licenses/gpl/html


http://www.gnu.org/licenses/old-licenses/lgpl-2.0.html
http://www.gnu.org/licenses/gpl/html

After Sales

Need help?

We’ re here for vou!

Online support: wavlink.com
Available Mon-Fri 8:30 am-5:30pm (UTC+8)

D

= support@wavlink.com
Available Mon-Fri 8:30 am—5:30pm (UTC+8)

o Tl 8889730883 (US Local)
% Mon-Fri 9:00 am — 10:00 pm (UTC-5)

www. wav]ink. com

 —1

Thank you for purchasing
WAVLINK product!







